Table of Contents

1. Introduction
   About the NVIDIA Control Panel ......................................................... 2
   Getting Support and Information ......................................................... 7

2. Understanding the NVIDIA Control Panel
   Opening and Closing the New NVIDIA Control Panel ............................ 10
   About the NVIDIA Control Panel Interface .......................................... 11

3. Accomplishing NVIDIA Control Panel Tasks
   Starting the NVIDIA Control Panel ...................................................... 22
   Accomplishing NVIDIA Control Panel Tasks ......................................... 24

A. Using NVIDIA SLI Technology
   Overview of SLI Technology for NVIDIA Quadro Cards ........................... 32
   Installation Instructions ........................................................................... 34
   Using NVIDIA SLI Frame Rendering or SLI Antialiasing Modes ................. 36
   Using SLI Multi-View Mode ...................................................................... 42

B. Multi-GPU Systems
   Configuring Multi-GPU Displays in the NVIDIA Control Panel ................ 44
   Understanding Multi-GPU Displays in the Windows Display Properties Settings Page ......................................................... 47

C. Professional 3D Stereo
   About Workstation 3D Stereo ................................................................... 54
   Using Workstation 3D Stereo .................................................................... 57

D. NVIDIA Application Configuration Engine
   Introduction ................................................................................................. 62
   Using ACE with Supported Applications ................................................. 63
   Using Applications that are not Supported by ACE ................................. 65
   Adding to the List of ACE-detectable Applications ................................... 68
   Frequently Asked Questions ..................................................................... 69
List of Figures

Figure 2.1  NVIDIA Control Panel (Windows XP Example)          12
Figure 2.2  NVIDIA Control Panel (Windows Vista)              13
Figure 2.3  NVIDIA Control Panel Select a Task pane         14
Figure 2.4  Toolbar                                          15
Figure D.1  Manage 3D Settings Page–ACE-detectable applications   63
Figure D.2  Manage 3D Settings Page–Applications with Global Profiles, Windows XP 65
NVIDIA Quadro Professional Driver User’s Guide

List of Tables

Table 2.1  File Menu Commands .................................................... 17
Table 2.2  Edit Menu Commands ................................................... 17
Table 2.3  View Menu Commands ................................................... 18
Table 2.4  Help Menu Commands .................................................. 18
Table 2.5  Profiles Menu Commands .............................................. 19
Table 2.6  Display Menu Commands ............................................... 19
Table 2.7  3D Settings Menu Commands .......................................... 19
Table 2.8  Workstation Menu Commands ........................................ 19
Table 3.1  Graphics Driver Tasks in the NVIDIA Control Panel ........... 24
Table B.1  Change Display Configuration Options ............................. 44
Table B.2  Windows Monitor Numbering Example—Four Connected Displays .......... 49
Table B.3  Windows Monitor Numbering Example—Six Potential Displays .......... 50
Table B.4  Windows Monitor Numbering Example—Default Boot Priority ........... 52
Table B.5  Windows Monitor Numbering Example—PCI Boot Priority ............. 53
Table C.6  List of Supported Stereo Display Modes ............................ 58
Table D.7  Application-specific Global Presets (Not supported by ACE) .......... 67
This quick start is addressed to users of the NVIDIA® Control Panel software. This guide focuses on getting you up and running with your NVIDIA software.

For technical details on the features and benefits of the NVIDIA Control Panel software and details about supported products, drivers, and other software, refer to the NVIDIA web page — www.nvidia.com.

This chapter discusses the following major topics:
- “About the NVIDIA Control Panel” on page 2
- “Getting Support and Information” on page 7
About the NVIDIA Control Panel

Welcome to the NVIDIA Control Panel, designed for Microsoft® Windows® XP, Windows Vista, and Windows 7. You can use NVIDIA Control Panel to control your NVIDIA hardware and access other NVIDIA software installed on your system.

Overview

In addition to setting up basic display configurations such as display resolution, refresh rate, and multiple display use, you can:

• Tune your 3D settings with real-time preview to maximize performance or image quality
• Customize how 3D applications work in your system
• Adjust your screen colors and contrast
• Set custom timings
• Control video image settings
• Change your HDTV format
• Control your notebook system power using PowerMizer
• Control special workstation features such as Frame Synchronization.

Feature Differences from the Classic Control Panel

The following are features that were available in the NVIDIA classic control panel, but which are not available in the new NVIDIA Control Panel:

• Creating/Importing Color Profiles
• High Resolution Scalable Desktop
• Video Zoom
• Full-screen video mirroring
• Edge Blending
• nView Desktop Manager

nView Desktop Manager is available through the Windows control panel as a separate applet (Windows XP and Windows Vista/Windows 7).
• MultiView Display Mode (for NVIDIA Quadro NVS graphics cards)
  MultiView is available from the Windows Display Properties->Settings->Advanced tab for Windows XP only.

Changes in Release 190

Display Settings Pages

• The following pages have been revised to include TV settings controls:
  • Adjust Desktop Color Settings
    Now includes controls to adjust TV color settings.
  • Change Resolution
    Now includes controls to adjust TV and HDTV signal formats and resolution.
  • Adjust Desktop Size and Position
    Now includes controls to adjust the TV screen size and position, and to resize the HDTV desktop.

• The following pages and links now appear in the Display category:
  • HDCP Status page
  • Digital Audio page

• After resizing the HDTV desktop, the new resolution created is now added to the list of available resolutions for that display, and also added to the resolution list within the game or application.

• The controls in the Manage Custom Resolutions page are now located in the Change Resolution page.

Video & Television Pages

• The following pages and controls have been moved to the Display category:
  • Adjust Television Color Settings page (see Display->Adjust Desktop Color Settings)
  • Change the signal or HD format page (see Display->Change Resolution)
  • Select Digital color format page (see Display->Change Resolution)
Chapter 1 NVIDIA Control Panel Quick Start Guide

Introduction

• Adjust screen size and position page (see Display->Adjust Desktop Size and Position)
• Resize HDTV desktop page (see Display->Adjust Desktop Size and Position)
• HDCP Status page
• Digital Audio page

3D Settings Pages

• Preferred Refresh Rate (Windows Vista and later)
  The Preferred Refresh Rate control lets you override the refresh rate limitations imposed by the 3D application for the indicated monitor.

• Power Management mode (Windows Vista and later)
  Many NVIDIA graphics cards support multiple performance levels so that the PC can save power when full graphics performance is not required. To provide more control over these power management capabilities, NVIDIA has added the Power Management Mode control. The control consists of two settings—Adaptive and Prefer Maximum Performance.

  Adaptive: This is the default setting in which the graphics card monitors GPU usage and seamlessly switches between modes based on the performance demands of the application. This allows the GPU to always use the minimum amount of power required to run a given application, and can allow even older 3D games to run in lower power modes if the game does not require full 3D performance. NVIDIA recommends this setting for best overall balance of power and performance.

  Prefer Maximum Performance: This setting lets you maintain the card at its maximum performance level when 3D applications are running regardless of GPU usage. This option can be set Globally (for all 3D applications), or an application profile can be created under Program Settings to set the preference for a particular 3D application.

  This feature is supported only on select GeForce 9 Series and later GPUs and applies only to DirectX and OpenGL-based applications.

Workstation Pages

The View System Topology page is now available with Windows Vista and later.
Supported Operating Systems

Release 190 of the Quadro professional drivers are available for the following Microsoft® Windows® operating systems:

- Windows XP Media Center Edition 2005 Update Rollup 2
- Windows XP Professional
- Windows XP Home Edition
- Windows XP Professional x64 Edition
- Windows Server 2003 x64 Edition
- Windows Vista Home Basic
- Windows Vista Home Premium
- Windows Vista Business
- Windows Vista Enterprise Edition
- Windows Vista Ultimate
- Windows 7 (32-bit and 64-bit editions)

Supported NVIDIA Products

Refer to the release notes and NVIDIA driver download site for the list of products supported by the driver version that you have installed on your computer.

Supported Languages

The NVIDIA Quadro Professional Driver supports the following languages in the NVIDIA Control Panel:

<table>
<thead>
<tr>
<th>Language</th>
<th>Language</th>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>English (USA)</td>
<td>German</td>
<td>Portuguese (Euro/Iberian)</td>
</tr>
<tr>
<td>English (UK)</td>
<td>Greek</td>
<td>Russian</td>
</tr>
<tr>
<td>Arabic</td>
<td>Hebrew</td>
<td>Slovak</td>
</tr>
<tr>
<td>Chinese (Simplified)</td>
<td>Hungarian</td>
<td>Slovenian</td>
</tr>
<tr>
<td>Chinese (Traditional)</td>
<td>Italian</td>
<td>Spanish</td>
</tr>
<tr>
<td>Czech</td>
<td>Japanese</td>
<td>Spanish (Latin America)</td>
</tr>
<tr>
<td>Danish</td>
<td>Korean</td>
<td>Swedish</td>
</tr>
<tr>
<td>Dutch</td>
<td>Norwegian</td>
<td>Thai</td>
</tr>
</tbody>
</table>
Other NVIDIA Software Applications

If installed, other NVIDIA software that you can access from the NVIDIA Control Panel includes:

- NVIDIA NVIDIA System Tools–Performance group and System Update
- NVIDIA Stereoscopic 3D
- NVIDIA MediaShield™
- NVIDIA Network Access Manager

See the respective user documentation for information about these applications and instructions on how to use them.
Getting Support and Information

Online Help

- To open the online help, either:
  - Press F1 on your keyboard, or
  - Select Help from the NVIDIA Control Panel menu bar and then select NVIDIA Control Panel Help.
- Help on various topics can be viewed using the Contents, Index, or Search tabs.

Also, when a setting on the control panel is disabled (grayed out) and you place the cursor on the setting, the User Assistance area indicates the reason it is disabled.

Technical Support

To access the NVIDIA Technical Support web page go the following web address:

http://www.nvidia.com/page/support.html
System Information

You can get detailed information about your system and the NVIDIA Control Panel configuration as well as version and copyright information.

- To view copyright and version information about the NVIDIA Control Panel:
  From the Help menu, select About NVIDIA Control Panel.

- To view detailed system information:
  Open the System Information dialog box by either selecting System Information from the Help menu, or by clicking the System Information link at the lower left corner of the NVIDIA Control Panel.
  Click any of the tabs in the System Information dialog box.
CHAPTER 2

UNDERSTANDING THE NVIDIA CONTROL PANEL

This chapter describes the NVIDIA Control Panel in the following sections:

- “Opening and Closing the New NVIDIA Control Panel” on page 10
- “About the NVIDIA Control Panel Interface” on page 11
Chapter 2
Understanding the NVIDIA Control Panel

Opening and Closing the New NVIDIA Control Panel

• You can open the NVIDIA Control Panel in several ways:
  • Right-click the Windows desktop, then click NVIDIA Control Panel from the context menu, or

  For Windows XP
  • From the Windows Start menu, select Control Panel, then in the Control Panel window, double-click on the NVIDIA Control Panel icon.

  NVIDIA Control Panel

  For Windows Vista/Windows 7
  • From the Classic View of the Windows Control Panel, click the NVIDIA Control Panel icon, or

  NVIDIA Control Panel

  • From the Control Panel Home view of the Windows Control Panel, click Additional Options and then click NVIDIA Control Panel from the Additional Options page.

• To close the NVIDIA Control Panel,
  • From the File menu, select Exit, or
  • Click the Close box in the upper right corner of the program window.
About the NVIDIA Control Panel Interface

The NVIDIA Control Panel provides an easy-to-use interface for managing your system.

When you start the program for the first time, the NVIDIA Control Panel opens to the first page listed in the navigation tree. On subsequent visits, the control panel reopens to the last page visited.

The NVIDIA Control Panel user interface consists of these main areas, as shown in Figure 2.1:

• Main Task Area
• Select a Task Navigation tree
• Menu bar
• Toolbar

While the look of the control panel varies depending on the operating system, the layout is the same for all operating systems.
Chapter 2
Understanding the NVIDIA Control Panel

Figure 2.1 NVIDIA Control Panel (Windows XP Example)
Figure 2.2  NVIDIA Control Panel (Windows Vista)
Chapter 2
Understanding the NVIDIA Control Panel

Using the Main Task Area

The main task area, in the right pane, displays the application task pages. This area of the screen is where you will focus most of your attention as you use the NVIDIA Control Panel to accomplish your goals. You can access specific pages using the navigation tree in the Select a Task pane.

Using the Select a Task Pane

The navigation tree in the Select a Task pane shows all the primary NVIDIA Control pages that are installed on your system.

The pages are grouped according to the same categories that existed in the previous version of the NVIDIA Control Panel.

Figure 2.3 NVIDIA Control Panel Select a Task pane
Understanding the NVIDIA Control Panel

Using the Tool Bar

The Tool Bar provides quick back and forth navigation between pages, and also lets you choose a view setting.

![Toolbar Image]

**Figure 2.4** Toolbar

Using the Navigation Buttons

The back and forward buttons let you navigate sequentially among pages that you have visited.

You can also navigate directly to a previously visited page by clicking the list arrow next to the back button. The drop-down menu lists all the previously visited pages in the queue. Click the page that you want.

Working with Views

The currently selected view determines what options are available. There are three available views:

- Standard
- Advanced
- Custom

Most commands are available for both Standard and Advanced views. However, some options are available only if the Advanced view is selected before opening the application category page. Also, task page options may be different depending on the selected view. If the command you're looking for is not displayed, return to the home page, select a different view, and return to the task page.
To change the view:

- From the View menu, select Standard, Advanced, or Custom.

Note: For the Custom command to be available, you must define a custom view as described in the following section.

**Defining Custom Views**

You can customize NVIDIA Control Panel to display only the application category pages you want to see and use.

To specify which the pages to display:

1. Select View > Define Custom View... or for quicker access, use the toolbar if you have it enabled.

2. On the Create Custom View page, for each application category that appears, select (check) the check boxes for the pages that you want to view and click OK.

3. To leave the Custom View mode, select either Standard or Advanced from the View menu or for quicker access, use the toolbar if you have it enabled.

4. To switch back to your custom view, select Custom.
Using the Menu Bar

The *Menu bar* contains standard Windows menus and menus specific to the NVIDIA Control Panel, such as the View and Profiles menus.

Menus that are available on the menu bar may vary, depending on the NVIDIA Control Panel category (such as, Display, Mobile, 3D Settings, or other category) you are using.

**File Menu**

Commands related to printing, applying changes, and exiting the program are available on the **File** menu.

<table>
<thead>
<tr>
<th><strong>Table 2.1</strong></th>
<th><strong>File Menu Commands</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File Menu Command</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Print...</td>
<td>Print the current task page.</td>
</tr>
<tr>
<td>Print Preview...</td>
<td>Preview the page before sending it to the printer.</td>
</tr>
<tr>
<td>Print Setup...</td>
<td>Open the Print Setup dialog box to adjust your printer properties.</td>
</tr>
<tr>
<td>Exit</td>
<td>Close the NVIDIA Control Panel program.</td>
</tr>
</tbody>
</table>

**Edit Menu**

Commands related to cutting, copying, pasting, and selecting items are available on the **Edit** menu.

<table>
<thead>
<tr>
<th><strong>Table 2.2</strong></th>
<th><strong>Edit Menu Commands</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit Menu Command</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Cut</td>
<td>Cut the selected text and place in the clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy the selected text and place in the clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Paste the text currently in the clipboard to the location of the Windows cursor.</td>
</tr>
<tr>
<td>Select All</td>
<td>Select all items on the current page.</td>
</tr>
</tbody>
</table>
View Menu

Commands related to viewing the various pages in the NVIDIA Control Panel application modules are available on the View menu.

Table 2.3 View Menu Commands

<table>
<thead>
<tr>
<th>View Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>Select to view and access the majority of commonly used and simpler tasks in the NVIDIA Control Panel applications. When the Standard command appears with a check mark, this means that the Standard view is currently active on your NVIDIA Control Panel.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select to view and access certain complex tasks in the NVIDIA Control Panel applications. These tasks often require some advanced experience using graphics hardware and software (drivers). When the Advanced command appears with a check mark, this means that the Advanced view is currently active on your NVIDIA Control Panel.</td>
</tr>
<tr>
<td>Custom</td>
<td>Select to choose a custom view. This command appears on the View menu only if you have used the Define Custom Views command to customize showing/hiding specific screens.</td>
</tr>
<tr>
<td>Define Custom View</td>
<td>To see only those application pages you want to see and use based on the application modules (Display, 3D Settings, etc.) that are installed on your system, select Define Custom Views from the View menu.</td>
</tr>
<tr>
<td>Add Desktop Context Menu</td>
<td>This is selected by default, and adds the NVIDIA Control Panel menu item to the desktop context menu.</td>
</tr>
<tr>
<td>Show Notification Tray Icon</td>
<td>(Windows XP only) Select to show the NVIDIA Control Panel notification tray icon in the Windows taskbar notification area. Clicking the NVIDIA Control Panel notification icon offers a quick way to configure key NVIDIA Control Panel settings.</td>
</tr>
</tbody>
</table>

Help Menu

Commands related to accessing help, system information, and copyright and version information are available on the Help menu.

Table 2.4 Help Menu Commands

<table>
<thead>
<tr>
<th>Help Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NVIDIA Control Panel Help</td>
<td>Access the NVIDIA Control Panel online help.</td>
</tr>
<tr>
<td>System Information</td>
<td>View detailed information about your system and the NVIDIA Control Panel configuration.</td>
</tr>
<tr>
<td>About NVIDIA Control Panel</td>
<td>View NVIDIA Control Panel version and copyright information.</td>
</tr>
</tbody>
</table>
Category-Specific Menus

The menus appear only when certain category pages are open.

Profiles Menu
Commands related to saving, loading, and deleting profiles are available on the Profiles menu.

Table 2.5 Profiles Menu Commands

<table>
<thead>
<tr>
<th>Profiles Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load...</td>
<td>Load a profile of display settings you have previously saved. Click to open the Load Desktop Profile dialog box and select a .nvp file.</td>
</tr>
<tr>
<td>Save...</td>
<td>Save the current configuration to a profile file. Click to open the Save Desktop Profile and enter a name and path for the .nvp file.</td>
</tr>
<tr>
<td>Delete...</td>
<td>Delete a profile. Click to open the Delete Desktop Profile dialog box and locate a profile to delete.</td>
</tr>
</tbody>
</table>

Display Menu
This menu item appears only when a Display category page is open.

Table 2.6 Display Menu Commands

<table>
<thead>
<tr>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identify Displays</td>
<td>Select to identify the displays configured with your system.</td>
</tr>
</tbody>
</table>

3D Settings Menu
This menu item appears only when a 3D Settings category page is open.

Table 2.7 3D Settings Menu Commands

<table>
<thead>
<tr>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show SLI Visual Indicators</td>
<td>Select to verify that SLI rendering is enabled and working.</td>
</tr>
</tbody>
</table>

Workstation Menu–
This menu item appears only when a Workstation category page is open.

Table 2.8 Workstation Menu Commands

<table>
<thead>
<tr>
<th>Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh View</td>
<td>Select to refresh the graphical representation of the displays and graphics cards installed on your system.</td>
</tr>
</tbody>
</table>
CHAPTER

3

ACCOMPLISHING NVIDIA CONTROL PANEL TASKS

This chapter provides instructions on how to use the NVIDIA Control Panel to accomplish common tasks. It contains the following sections:

- Starting the NVIDIA Control Panel
- Accomplishing NVIDIA Control Panel Tasks

Note: For Windows Vista and Windows 7—Several features are currently under development for Windows Vista or Windows 7 and are not yet supported in the NVIDIA Control Panel. Consult the release notes for the latest list of unsupported features.
Starting the NVIDIA Control Panel

1. Launch the NVIDIA Control Panel:
   - Right-click the Windows desktop, then click NVIDIA Control Panel from the context menu, or

   **Under Windows XP:**
   a. From the Windows Start menu, select Control Panel
   b. In the Control Panel window, double-click the NVIDIA Control Panel icon.

   **Under Windows Vista:**
   a. Click the Start icon, then from the Start menu click Control Panel
   b. From the Classic View of the Windows Vista Control Panel, click the NVIDIA Control Panel icon, or

      From the Control Panel Home view of the Windows Vista Control Panel, click Additional Options and then click NVIDIA Control Panel from the Additional Options page.
The categories that appear in the Select a Task pane depend on which NVIDIA software is installed on your system. For example, the Mobile category is not available on desktop systems.

2 From the navigation tree in the Select a Task pane, click one of the links to open a specific task page.

Each category in the navigation tree lists different tasks that you can accomplish, and each task page provides instructions on how to accomplish what you want. Move the cursor over listed options to see a description and typical usage scenario for that option.

Detailed instructions for each task are also available through the online help.
Accomplishing NVIDIA Control Panel Tasks

Guide to Locating Tasks

Table 3.1 lists the page in the NVIDIA Control Panel where you can find controls for accomplishing various graphics driver tasks.

**Table 3.1** Graphics Driver Tasks in the NVIDIA Control Panel

<table>
<thead>
<tr>
<th>Feature</th>
<th>NVIDIA Control Panel Category - Page</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Timings Display</td>
<td>Display - Manage Custom Resolutions</td>
<td></td>
</tr>
<tr>
<td>Antialiasing</td>
<td>3D Settings - Manage 3D Settings</td>
<td></td>
</tr>
<tr>
<td>Application Profiles</td>
<td>3D Settings - Manage 3D Settings</td>
<td></td>
</tr>
<tr>
<td>Color Depth</td>
<td>Display - Change Resolution</td>
<td></td>
</tr>
<tr>
<td>Custom Timings Display</td>
<td>Display - Manage Custom Resolutions</td>
<td></td>
</tr>
<tr>
<td>Desktop Color Settings</td>
<td>Display - Adjust Desktop Color Settings</td>
<td></td>
</tr>
<tr>
<td>Driver Settings Display</td>
<td>3D Settings - Manage 3D Settings</td>
<td></td>
</tr>
<tr>
<td>Desktop Overlap Display</td>
<td>Workstation - Adjust Edge Overlap</td>
<td>Available only with WindowsXP.</td>
</tr>
<tr>
<td>Frame Synchronization</td>
<td>Workstation - Synchronize Displays</td>
<td>Available only with WindowsXP. Requires NVIDIA Quadro G-Sync card.</td>
</tr>
<tr>
<td>HDTV Setup</td>
<td>Display - ChangeResolution</td>
<td></td>
</tr>
<tr>
<td>Multi-display configuration</td>
<td>Display - Set Up Multiple Displays</td>
<td></td>
</tr>
<tr>
<td>nView Clone Mode Display</td>
<td>Display - Set Up Multiple Displays</td>
<td></td>
</tr>
<tr>
<td>nView Span Modes Display</td>
<td>Display - Set Up Multiple Displays</td>
<td>Available only with WindowsXP.</td>
</tr>
<tr>
<td>NVRotate</td>
<td>Display - Rotate Display</td>
<td></td>
</tr>
<tr>
<td>Performance and Quality Settings</td>
<td>3D Settings - Adjust Image Settings with Preview</td>
<td></td>
</tr>
<tr>
<td>PowerMizer</td>
<td>Mobile - Change PowerMizer Settings</td>
<td>Available only with notebook computers. Available only with WindowsXP.</td>
</tr>
<tr>
<td>Refresh Rate Settings</td>
<td>Display - Change Resolution</td>
<td></td>
</tr>
<tr>
<td>Resolution Settings</td>
<td>Display - Change Resolution</td>
<td></td>
</tr>
<tr>
<td>Screen Position on CRT</td>
<td>Display - Adjust Desktop Size and Position</td>
<td></td>
</tr>
</tbody>
</table>
Table 3.1  Graphics Driver Tasks in the NVIDIA Control Panel

<table>
<thead>
<tr>
<th>Feature</th>
<th>NVIDIA Control Panel Category - Page</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen Position on TV</td>
<td>Display - Adjust Desktop Size and Position</td>
<td></td>
</tr>
<tr>
<td>SDI (Graphics to SDI Output)</td>
<td>Workstation - Send Graphics to SDI Output</td>
<td>Available only with WindowsXP.</td>
</tr>
<tr>
<td>SLI Configuration</td>
<td>3D Settings - Set SLI Configuration</td>
<td></td>
</tr>
<tr>
<td>Temperature Settings</td>
<td>Performance</td>
<td>Requires NVIDIA System Tools software</td>
</tr>
<tr>
<td>TV Setup</td>
<td>Display - Change Resolution</td>
<td></td>
</tr>
<tr>
<td>Video Color Settings</td>
<td>Video &amp; Television - Adjust Video Color Settings</td>
<td></td>
</tr>
<tr>
<td>Overclocking</td>
<td>Performance</td>
<td>Requires NVIDIA System Tools software</td>
</tr>
</tbody>
</table>
NVIDIA Control Panel Groups

This section provides an overview of the NVIDIA Control Panel groups.

- “Using the Display Category Pages” on page 26
- “Using the Video Category Pages” on page 27
- “Using the 3D Settings Category Pages” on page 27
- “Using the Mobile Category Pages” on page 28
- “Using the Workstation Category Pages” on page 28
- “Using the Networking Pages” on page 29
- “Using the Storage Pages” on page 29
- “Using the Performance Pages” on page 30
- “Using the System Update Pages” on page 30
- “Using the Stereoscopic 3D Pages” on page 30

Note: For Windows Versions—Support for some features under Windows Vista or Windows 7 is in development and may not be available with your ForceWare graphics driver version. Consult the release notes for the latest list of unsupported features.

Using the Display Category Pages

The actual tasks available on your system depend on your system hardware, such as the number and type of displays connected. Use the Display category pages to:

- Run the wizard to optimize your display configuration
- Change the display resolution
- Change the scaling on your flat panel display
- Adjust color settings
- Rotate the display
- Adjust custom timings (available under Advanced View)
- Configure multiple displays, including Spanning or Clone modes.
  
 spanning modes are available only with Windows XP.
- Adjust your television picture quality and video color settings for the best possible viewing in its environment.
- Change the position and size of the desktop/video to best fit your television or HDTV (high definition television) screen.
• Change the signal format to use for your standard television or HDTV as well as change country-specific signal or the HDTV format.
• Verify the HDCP capability of your system.
• Access digital audio controls.

Using the Video Category Pages

The actual tasks available on your system depend on your system hardware, such as whether or not you have a TV connected. Use the Video page to:
• Adjust video and image color settings.

Using the 3D Settings Category Pages

The actual tasks available on your system depend on your system hardware, such as whether or not you have an SLI-ready system. Use the 3D Settings page to:
• Change the image and rendering settings of your 3D applications and games that utilize Direct3D and OpenGL technology
• Assign specific 3D settings to a game so that these settings automatically load when a game is launched (available under Advanced view)
• Set up your SLI or multi-GPU configuration

Note: GPU temperature monitoring and GPU overclocking features are not included in the 3D Settings page in Release 95 and later. To use this functionality you must install NVIDIA nTune software.
Using the Mobile Category Pages

The Mobile category is available if the NVIDIA software is installed on a notebook computer.

**Note:** The Mobile page is not available under Windows Vista or Windows 7.

The actual tasks available depend on which features are included with your notebook system. Use the Mobile page to extend your notebook computer's battery life using NVIDIA PowerMizer technology.

Using the Workstation Category Pages

The Workstation category is available if you have an NVIDIA Quadro FX graphics card installed.

The actual tasks available depend on which NVIDIA Quadro FX product you have installed. Use the Workstation page to:

- Synchronize your displays using frame sync or genlock technology
- View a graphical representation of the displays and graphics cards installed on your system.
- Manage serial digital interface (SDI) output (requires NVIDIA Quadro FX SDI solution.)
- Overlap the edges of adjacent displays.

**Note:** Display edge blending is no longer available.
Using the Networking Pages

The Networking group pages are part of the nForce drivers Networking software for NVIDIA nForce-based PCs.

Use the Networking pages to optimize your network performance and increase your network bandwidth with the following technologies:

- **NVIDIA FirstPacket** offers a new way to manage the traffic on your personal computer, allowing you to more effectively manage and improve the performance of networked games and other applications that are sensitive to network delay (latency), such as Voice-over-IP (VoIP).

- **NVIDIA TCP/IP Acceleration** technology is a networking solution that moves the processing of TCP/IP network traffic from your computer's CPU to its nForce hardware resulting in greatly improved system performance.

- **NVIDIA Teaming** technology combines all the NVIDIA Ethernet interfaces on your system to form a team, resulting in increased bandwidth and network redundancy.

- **Alert Standard Format (ASF)** controls lets you set up alerts and remote system management in an OS-present or OS-absent environment.

Using the Storage Pages

The Storage group pages are part of the nForce drivers MediaShield Storage software for NVIDIA nForce-based PCs.

Use the Storage pages to:

- Create and manage RAID 0, RAID 1, RAID 0+1, RAID 5, and spanning arrays.
- Run SMART tests on your RAID array disk drives.
Chapter 3
Accomplishing NVIDIA Control Panel Tasks

Using the Performance Pages

The Performance group pages are part of the nForce drivers System Tools software for NVIDIA nForce-based PCs.

Use the Performance pages to:
- Manage system tuning and profiles for nForce MCP clocks, voltages, timings, and fans.
- Manage Enthusiast System Architecture (ESA) components.
- View detailed system information for your nForce-based PC.
- Overclock your GeForce GPU.

Using the System Update Pages

The System Update pages are part of the nForce drivers System Tools software for NVIDIA nForce-based PCs.

Use the system update pages to:
- Automatically check for nForce and GeForce driver updates.
- Update your system BIOS.
- Update firmware for the Enthusiast System Architecture (ESA) components.

Using the Stereoscopic 3D Pages

The Stereoscopic 3D pages are installed as part of the NVIDIA Stereoscopic 3D Driver for viewing many games in 3D stereo.

Use the stereoscopic 3D pages to:
- Control stereoscopic 3D settings
  Enable stereoscopic 3D, adjust 3D depth, select a 3D laser sight, view and set the keyboard shortcuts, and run the setup wizard and various tests.
- Determine 3D game compatibility
  See a stereoscopic 3D compatibility rating for a number of games, along with possible issues and recommendations for each game.
NVIDIA Corporation

APPENDIX

USING NVIDIA SLI TECHNOLOGY

NVIDIA SLI technology lets you install and benefit from two PCI Express (PCIe) graphics boards in a single PC. Just as dual processors or dual core CPUs improve computer performance, SLI allows dual GPUs (Graphics Processing Units) to significantly accelerate graphics performance.

This chapter explains how to install, configure, and use NVIDIA SLI graphics cards as supported in the Quadro Professional drivers.

• “Overview of SLI Technology for NVIDIA Quadro Cards” on page 32
• “Installation Instructions” on page 34
• “Using NVIDIA SLI Frame Rendering or SLI Antialiasing Modes” on page 36
• “Using SLI Multi-View Mode” on page 42
Overview of SLI Technology for NVIDIA Quadro Cards

Professional users benefit by using SLI technology on dual NVIDIA Quadro GPUs to span an OpenGL window across multiple displays, or to run a single application on each GPU. The SLI connector offers dual GPU performance on a single display by leveraging the capabilities of two NVIDIA Quadro GPUs.

SLI Modes for NVIDIA Quadro GPUs

There are three SLI functions available for NVIDIA Quadro GPUs:

**SLI Frame Rendering Mode**

SLI frame rendering combines two PCI Express graphics boards with an SLI connector to transparently scale application performance on a single display by presenting them as a single graphics card to the operating system. SLI frame rendering accelerates OpenGL operation in two different ways:

- **Split frame rendering**: In split-frame rendering (SFR), the display is split into distinct sections, and each section is sent to a different GPU. The resulting rendering is recomposed and displayed as a single contiguous frame. The position of the split is adjusted dynamically as the workload moves between the GPUs. SFR typically benefits pixel-shader or texture-intensive operations.

- **Alternate frame rendering**: In alternate frame rendering (AFR), each GPU renders alternate frames of data from the application. AFR typically benefits geometry-intensive operations.

**SLI Full Scene Antialiasing Mode**

SLI anti-aliasing combines the power of two PCI Express graphics boards to offer higher quality anti-aliasing.

**SLI Multi-View Mode**

SLI multi-view combines the power of two NVIDIA Quadro PCI Express graphics boards to span a single hardware-accelerated OpenGL application window across multiple displays, run a single application per GPU with multiple display outputs, or enable other uses of two PCI Express graphics boards.
Appendix A
Using NVIDIA SLI Technology

Hardware Requirements

To support NVIDIA SLI technology, the motherboard and system must include the following:

**Motherboard**

Your PC motherboard must be PCI Express-based, with two available and adjacent PCI Express expansion slots. Both slots must be x16 mechanical with the following allowed electrical slots:

- x16 + x16
- x16 + x8
- x16 + x4
- x8 + x8

**Graphics Cards**

NVIDIA SLI requires two SLI graphics cards.

- **For SLI Frame Rendering or SLI Antialiasing**
  - Two identical NVIDIA Quadro FX 5800, 5600, 5500, 4800, 4600, 4500 X2, 4500, 3500, 3450, or 3400 graphics cards
  - An SLI bridge connector (provided with your graphics board) must also be installed to utilize the full capabilities of SLI Frame Rendering.

- **For SLI Multi-View**
  - Two identical NVIDIA Quadro FX 5800, 5600, 5500, 4800, 4600, 4500 X2, 4500, 3500, 3450, 3400, 1500, 1400, 560, 550 or 540 graphics cards

**Power supply**

- Some SLI-ready graphics boards require an external power cable.
- Since NVIDIA SLI technology supports up to two high-end graphics boards, the load on the system’s power supply can increase significantly. A minimum of a 480W Power Supply Unit (PSU) is recommended.
  
  An inadequate power supply will result in erratic and unpredictable system behavior.

See the NVIDIA SLI website for updated hardware requirements information.
Appendix A
Using NVIDIA SLI Technology

Installation Instructions

Before removing current graphics boards and installing two NVIDIA Quadro FX boards, please uninstall any current drivers and save on your Windows desktop the provided SLI drivers.

Installing the Hardware

Note: Perform the installation in a static safe environment and utilize a properly grounded anti-static wristband. Place any static sensitive components in anti-static bags.

1 Power off the system and remove the power cord from the power supply.

2 Gently remove or open the system enclosure.
   Refer to owners manual that came with your computer.

3 Remove any non SLI-capable graphics boards that may occupy the x16 expansion slot and replace it with your NVIDIA SLI-ready graphics board.

4 Install the second SLI-capable graphics board in the adjacent slot.
   You may also need to relocate a card. The chosen slot must be x16, x8 or x4 capable.

5 Connect the two graphics boards with the SLI bridge connector.

The SLI connector is required for SLI Frame Rendering and SLI Antialiasing.
6 If your graphics boards have an auxiliary power connector, connect them to the power supply using the supplied power connector cables.

7 Replace the system’s cover and reconnect your display(s) to the SLI-ready graphics board installed in the x16 expansion slot.

8 Plug the power cable back into the system.

Installing the Display Driver

Follow the steps listed below to install your driver software:

1 Power on the system and log into Windows.

2 Cancel the Windows “Found New Hardware Wizard”.
   This message should appear twice – once for each graphics board.

3 Run “setup.exe” for the SLI driver you saved to your desktop.

4 Follow the “Next” prompts to proceed with driver installation.

5 Once the software has been installed, choose “Yes, I want to restart my computer now” and select “Finish” to reboot the system.

See the following sections for instructions on using NVIDIA SLI Technology:

- “Using NVIDIA SLI Frame Rendering or SLI Antialiasing Modes” on page 36
- “Using SLI Multi-View Mode” on page 42
Appendix A
Using NVIDIA SLI Technology

Using NVIDIA SLI Frame Rendering or SLI Antialiasing Modes

Note: Before enabling SLI technology, you must close any 3D applications that are using the NVIDIA driver. When SLI is enabled, the video driver is reset in order to enable the second GPU. If an application that uses the graphics driver is still open while the driver resets, this could result in a black screen or cause the system to hang.

There are two basic steps for using SLI frame rendering and antialiasing modes:

1 Enable SLI Mode
2 Select the NVIDIA SLI Mode to Use (such as SLI frame rendering or SLI antialiasing)

These steps are described in detail in the following sections.

Enable SLI Mode

1 After logging back on to Windows, you should see the message “SLI capable system” in the bottom right corner of the screen.

On some configurations, the message will state that SLI mode is automatically enabled. In that case you can skip the remaining instructions in this section and proceed to “Select the NVIDIA SLI Mode to Use” on page 38.

2 Click anywhere on the message.
   If the message disappears before you can click it, continue with the following steps.

3 Right click the desktop and click NVIDIA Control Panel.

4 Under the 3D Settings category, click Set SLI configuration.

5 Click Enable SLI technology.
Systems with four NVIDIA SLI-ready GPUs in an SLI PC are indicated by the text **Enable Quad SLI technology**.

6 If you have more than one display connected, continue the following steps, otherwise click Apply.

**Windows XP or pre-GeForce 8 series GPUs**

a Under **Select the display to view SLI rendered content on**, click the list arrow and select the display that you want to use to view your game.

The GPU connected to this display will function as the "primary" GPU, all others will function as slaves to the primary GPU.

b Click Apply.

**Windows Vista/Windows 7 and GeForce 8 series and later GPUs**

a Under **Select the SLI focus display**, click the list arrow and then select the display to which you want to apply full SLI acceleration for full-screen applications.

You can see content on other displays connected to the same GPU, but SLI acceleration will not be maximized.

b Click Apply.

To use SLI frame rendering or SLI antialiasing technology, you must configure the **SLI performance mode** as explained in the next section.
Appendix A
Using NVIDIA SLI Technology

Select the NVIDIA SLI Mode to Use

This section explains how to select and use the following SLI features:

• SLI Frame Rendering
• SLI Antialiasing Mode
• SLI Single-GPU Mode
• Using the Preset 3D App Profiles
• Viewing Load Balancing

SLI Frame Rendering

To use SLI frame rendering, perform the following steps:

1. From the NVIDIA Control Panel tool bar, switch to Advanced View and then click Manage 3D Settings from the Select a Task pane.

2. Click the Global Settings tab, and then click the Global presets list arrow and select Base profile.

3. Under the Settings Feature column, locate SLI performance mode, click its setting to activate the list box, then click the performance mode you want to use.

   See “SLI Frame Rendering Mode” on page 32 for an explanation of split frame rendering and alternate frame rendering.

4. Click Apply.
SLI Antialiasing Mode

You can use SLI technology to provide higher-quality antialiasing beyond 16xFSAA. In this mode, neither AFR nor SFR are available. To use SLI antialiasing, perform the following steps.

1 Enable SLI antialiasing.
   a From the NVIDIA Control Panel tool bar, switch to Advanced View and then click Manage 3D Settings from the Select a Task pane.
   b Click the Global Settings tab, and then click the Global presets list arrow and select Base profile.
   c Under the Settings Feature column, locate SLI performance mode, click its setting to activate the list box, then click SLI antialiasing.

2 Select an SLI antialiasing setting.
   Under the Settings Feature column,
   a Locate Antialiasing-Mode, click its setting to activate the list box and then click Enhance the application setting.
   b Locate Antialiasing - Setting, click its setting to activate the list box, then click the SLI antialiasing setting you want to use.

3 Click Apply.

SLI Single-GPU Mode

SLI single-GPU mode is the default setting, and provides improved performance at a level that assures compatibility with most applications. This is not the same as completely disabling SLI. If you are trying to solve a compatibility issue, you may want to completely disable SLI by clearing the Enable SLI technology check box on the Manage 3D Settings > Set SLI Configuration page.

To use single GPU mode, perform the following steps.

1 From the NVIDIA Control Panel tool bar, switch to Advanced View and then click Manage 3D Settings from the Select a Task pane.

2 Click the Global Settings tab, and then click the Global presets list arrow and select Base profile.
Appendix A
Using NVIDIA SLI Technology

3 Under the Settings Feature column, locate SLI performance mode, click its setting to activate the list box, then click SLI single-GPU.

4 Click Apply.

Using the Preset 3D App Profiles

The following three preset application profiles for OpenGL applications are useful in SLI configurations:

• 3D App-Modeling AFR
  This preset is useful for modeling applications, and uses SLI AFR mode.

• 3D App-Visual Simulation
  This preset is useful for visual simulation applications, and uses SLI SFR mode.

• 3D App-Default Global Settings
  This preset uses SLI single-GPU rendering mode, and is also useful when you need to use non-SLI configurations.

To enable one of these profiles, click the Global Settings tab in the Manage 3D Settings page, then click the Global presets list arrow and click the profile you want to use.

Viewing Load Balancing

To view the relative amount of work, or load balancing, performed by each GPU in DirectX and OpenGL applications,

1 From the NVIDIA Control Panel Select a Task pane, click Set SLI configuration.

2 From the menu bar, click 3D Settings, then click the drop-down menu item Show SLI Visual Indicators.

This option enables an SLI status bar that reflects how the GPUs are working together to render DirectX and OpenGL full-screen applications. See Figure A.1.
Appendix A
Using NVIDIA SLI Technology

Figure A.1 Load Balancing Indicators

AFR load balancing bar shows relative work provided by each GPU.

SFR load balancing line shows relative portion of the screen rendered by each GPU.

SLI AA indicator shows the effect of SLI antialiasing modes.
Using SLI Multi-View Mode

To use SLI multi-view mode:

1. Disable SLI multi-GPU mode.
   a. Right click the desktop and click NVIDIA Control Panel.
   b. From the 3D Settings category in the Select a task pane, click Set SLI configuration.
   c. Clear the Enable SLI technology check box, then click Apply.

If you were using SLI multi-view mode prior to enabling SLI frame rendering mode and you still have multiple displays connected, then the system returns to the previous multi-view mode, whether it was Dualview, Clone, or Spanning mode.

If you have only one display connected, then the system sets to single display mode. Continue with the following steps to use additional displays.

2. Close the NVIDIA Control Panel and then connect the additional displays that you want to use.

3. Enable the displays per the instructions in the section “Configuring Multi-GPU Displays in the NVIDIA Control Panel” on page 44.
This appendix discusses multi-GPU display configuration in a non-SLI (or SLI Multi-view) configuration. It contains the following sections:

- “Configuring Multi-GPU Displays in the NVIDIA Control Panel” on page 44
- “Understanding Multi-GPU Displays in the Windows Display Properties Settings Page” on page 47
Appendix B
Multi-GPU Systems

Configuring Multi-GPU Displays in the NVIDIA Control Panel

Multi-GPU systems are typically systems with more than one graphics card installed, but they can also include systems with one or more NVIDIA Quadro NVS 400 cards, or one or more NVIDIA Quadro FX 4500 FX2 graphics cards.

In a multi-GPU system, you use the NVIDIA Control Panel to control the multi-display mode (single, Dualview, Clone, or Spanning) in the same manner as you would in a single-GPU system—from the Set up Multiple Displays page.

Windows XP

You can only configure displays from one “GPU” at a time. So the basic steps are as follows:

1. Select the GPU using the Select the graphics card with the displays you want to configure list.

2. Configure the displays attached to that GPU.

Table B.1 shows the options you can expect to see for each GPU, depending on how many displays are connected to the GPU.

Table B.1  Change Display Configuration Options

<table>
<thead>
<tr>
<th>Displays Connected</th>
<th>nView Display Mode Options</th>
<th>Displays to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Single</td>
<td>Display A</td>
</tr>
</tbody>
</table>
Table B.1 Change Display Configuration Options

<table>
<thead>
<tr>
<th>Displays Connected</th>
<th>nView Display Mode Options</th>
<th>Displays to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Single</td>
<td>Display A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Display B</td>
</tr>
<tr>
<td></td>
<td>Multi-display modes</td>
<td>Display A + B</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Display B + A</td>
</tr>
<tr>
<td>2 + TV</td>
<td>Single</td>
<td>Display A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Display B</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Display TV</td>
</tr>
<tr>
<td></td>
<td>Multi-display modes</td>
<td>Display A + B</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Display B + A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Display A + TV</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Display TV + A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Display B + TV</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Display TV + B</td>
</tr>
</tbody>
</table>

Windows Vista/Windows 7

You can configure displays from several “GPUs” at a time.

On the Set Up Multiple Displays page, the box under Step 1 lists all the displays that are connected to your system, and shows to which GPU they are connected.

Check or clear the check boxes to select the displays that you want to use, then click Apply to activate the new display configuration.

The displays will be in either extended mode or Clone mode.
Extended mode displays are identified by number in separate box icons.

- The numbering corresponds to the numbering in the Windows Display Settings page.
- The Windows primary display is indicated by the box icon with a star.
- To switch from extended mode to Clone mode, right-click the display icon for the display that you want to make a clone of another, click the Clone option from the pop-up menu, then click Apply.

Cloned displays are identified by numbers inside the same box icon.

- If the box icon has a star, this indicates that Windows sees that display group as the primary Windows display.
- To switch from Clone mode to extended mode, right-click the display icon for the display that you want to make the secondary extended mode display, click the Clone option from the pop-up menu to clear the check box, then click Apply.
Understanding Multi-GPU Displays in the Windows Display Properties Settings Page

The following explanation describes the monitor icons for multiple displays in the Windows Display Properties Settings page.

- Overview of Dualview Monitors in a Multiple-GPU System
- Monitor Order: Windows Vista Versus Windows XP
- Monitor Icons: Windows Vista/7 Versus Windows XP
- Monitor Icons: nView Clone and Spanning Mode
- Determining GPU Order

Overview of Dualview Monitors in a Multiple-GPU System

In Dualview mode, the displays are recognized by the operating system and you can configure each display independently. You can also attach or remove Dualview displays using the Display Properties Settings page.

Figure B.1 illustrates the Display Properties Settings page for a system with four displays connected in a Dualview configuration under Windows Vista.
Figure B.1 Dualview Mode with Four Displays Attached

The monitor ordering is controlled by a combination of the driver and the Windows method of enumerating PCI devices. Because a number of factors are involved in the enumeration of the displays, it can be difficult to predict which display icon in the Windows Display Properties page corresponds to which display connector on the graphic cards.

To accurately determine which icon represents which display,

1. If the display in question is already attached, skip this step. Otherwise, attach the display by right-clicking the icon and clicking **Attached**, then click **Apply**.

2. Right click the icon again and click **Identify**.
   The icon number appears on the display.
Monitor Order: Windows Vista Versus Windows XP

This section describes how monitors are ordered when all the displays in a multi-GPU system are connected.

Monitor Ordering Under Windows XP

Windows XP enumerates one display from the GPU and then considers the display from the next GPU. After it enumerates the display from the last GPU, the operating system goes back to the first GPU to enumerate the secondary display, and so on.

Monitor Ordering Under Windows Vista and Windows 7

Windows Vista enumerates all display outputs from a GPU before considering the next GPU.

Monitor Order Example

Table B.2 gives an example of four monitors connected to two GPUs, and shows the general pattern the operating system uses to enumerate the monitors under Windows Vista and Windows XP.

Table B.2  Windows Monitor Numbering Example—Four Connected Displays

<table>
<thead>
<tr>
<th>Connector Position</th>
<th>Monitor Number Under Windows Vista/Windows 7</th>
<th>Monitor Number Under Windows XP</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPU0—Output 1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>GPU0—Output 2</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>GPU1—Output 1</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>GPU1—Output 2</td>
<td>4</td>
<td>4</td>
</tr>
</tbody>
</table>
Monitor Icons: Windows Vista/7 Versus Windows XP

This section describes how monitors are ordered when not all the displays in a multi-GPU system are connected or enabled under Dualview.

Monitor Icons Under Windows XP

• Each GPU is represented by a monitor icon, regardless of whether a monitor is connected to it.
• If a secondary display on a GPU is connected but not enabled under Dualview, there is a monitor icon for that display but it is grayed out.
• If a secondary display on a GPU is not connected, there is no monitor icon for that display.

Monitor Icons Under Windows Vista/Windows 7

• The Display Properties page shows all the monitors that can be supported by the graphics cards in the system, even if they are not physically connected.
• If a display is not connected, or connected but not enabled under Dualview, the corresponding monitor icon is grayed out.

Monitor Order Example

Table B.3 shows the general monitor numbering under Windows Vista and Windows XP when only some of the displays are connected. Monitor numbers are always sequential, even when displays are not connected.

Table B.3  Windows Monitor Numbering Example–Six Potential Displays

<table>
<thead>
<tr>
<th>Connector Position</th>
<th>Connection Status</th>
<th>Monitor Number Under Windows Vista/Windows 7</th>
<th>Monitor Number Under Windows XP</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPU0—Output 1</td>
<td>Connected</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>GPU0—Output 2</td>
<td>Connected</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>GPU1—Output 1</td>
<td>Connected</td>
<td>3 (grayed)</td>
<td>2 (represents GPU1)</td>
</tr>
<tr>
<td>GPU1—Output 2</td>
<td>Connected</td>
<td>4 (grayed)</td>
<td></td>
</tr>
<tr>
<td>GPU2—Output 1</td>
<td>Connected (not enabled)</td>
<td>5 (grayed)</td>
<td>3 (grayed)</td>
</tr>
<tr>
<td>GPU2—Output 2</td>
<td></td>
<td>6 (grayed)</td>
<td></td>
</tr>
</tbody>
</table>
Monitor Icons: nView Clone and Spanning Mode

Only outputs from the same GPU can be grouped together in nView Span mode or nView clone mode.

When you enable **nView Clone mode**, Windows recognizes only the nView primary display as connected, and the display corresponding to the nView secondary clone mode display is shown to be *not attached* in the Display Properties Settings page.

When you enable **nView Horizontal or Vertical Spanning mode**, Windows recognizes only the nView primary display as connected, and considers it to have a resolution equal to the combined resolutions of both displays. The display corresponding to the nView secondary spanning mode display is shown to be *not attached* in the Display Properties Settings page.

**Figure B.2** illustrates the Display Properties Settings page for a system with four displays where displays 1 and 3 are in a Clone mode configuration and displays 4 and 2 are in a Spanning mode configuration.
Determining GPU Order

The following are guidelines to help determine the order in which GPUs are considered when the operating system enumerates displays.

Default GPU Order

Table B.4 shows which GPU is designated as GPU0 for the purpose of monitor ordering in a multiple-GPU system.

Table B.4   Windows Monitor Numbering Example—Default Boot Priority

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Which GPU is considered first</th>
</tr>
</thead>
<tbody>
<tr>
<td>AGP + PCI</td>
<td>GPU on the AGP bus (by default)</td>
</tr>
<tr>
<td>PCI-E + PCI</td>
<td>GPU on the PCI-E bus (by default)</td>
</tr>
<tr>
<td>NVIDIA Quadro NVS 400 (or other multi-GPU graphics cards)</td>
<td>GPU driving the monitor connector closest to the card edge connector.</td>
</tr>
<tr>
<td>NVIDIA Quadro NVS 440</td>
<td>GPU driving the monitor connector farthest way from the card edge connector.</td>
</tr>
</tbody>
</table>
Monitor Order After Changing the GPU Boot Priority in the BIOS

By default, in a multi-graphics card system the AGP or PCI-E bus has boot priority in the system BIOS, meaning that GPU0 resides on the AGP or PCI-E graphics card and displays are enumerated beginning with that GPU.

If you change the boot priority to the PCI bus, displays are enumerated in the same order except that the first display is enumerated from the GPU on the PCI bus. After that, the GPUs and displays are enumerated in the standard priority, as shown in Table B.5.

Table B.5  Windows Monitor Numbering Example—PCI Boot Priority

<table>
<thead>
<tr>
<th>Connector Position</th>
<th>Monitor Number Under Windows Vista/Windows 7</th>
<th>Monitor Number Under Windows XP</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPU0 (AGP/PCI-E)—Output 1</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>GPU0 (AGP/PCI-E)—Output 2</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>GPU1 (AGP/PCI-E)—Output 1</td>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td>GPU1 (AGP-PCI-E)—Output 2</td>
<td>6</td>
<td>5</td>
</tr>
<tr>
<td>GPU2 (PCI)—Output 1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>GPU2 (PCI)—Output 2</td>
<td>2</td>
<td>6</td>
</tr>
</tbody>
</table>
This appendix discusses professional or quad-buffered 3D stereo. It contains the following sections:

- “About Workstation 3D Stereo” on page 54
- “Using Workstation 3D Stereo” on page 57

About Workstation 3D Stereo

The NVIDIA graphics driver comes with built-in support for 3D stereoscopic viewing of OpenGL applications developed for 3D stereo. This is also referred to as “professional”, “workstation”, or “quad-buffered” stereo1.

Basic Workstation 3D Stereo Requirements

To use workstation stereo, you need the following:

- OpenGL application that is developed for stereo
  The application must be designed to render different content to the left and right eye.
- NVIDIA Quadro graphics card, except NVIDIA Quadro NVS cards
- Proper driver configuration through the NVIDIA Control Panel

1. This is not to be confused with the NVIDIA consumer 3D stereo driver that lets you view 3D applications in stereo even if they are not developed for stereo.
Using 3D Stereo under Different System Configurations

Supported Stereo Configurations Under Windows XP

The NVIDIA drivers support both full-screen and windowed stereo under Windows XP. Table C.1 details which stereo modes are supported under which GPU/display configurations.

Table C.1  Supported Workstation Stereo Configurations under Windows XP

<table>
<thead>
<tr>
<th>System Configuration</th>
<th>Active Stereo Display Modes</th>
<th>Passive Stereo Display Modes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single GPU - Single display</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Single GPU - Multiple displays</td>
<td>Supported</td>
<td>Supported (including CloneMode)</td>
</tr>
</tbody>
</table>

See Using Workstation 3D Stereo with Multiple Displays for more information.

<table>
<thead>
<tr>
<th>System Configuration</th>
<th>Active Stereo Display Modes</th>
<th>Passive Stereo Display Modes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-system - Multiple displays</td>
<td>Supported</td>
<td>Supported (including CloneMode)</td>
</tr>
</tbody>
</table>

Requires a G-Sync or G-Sync II card with all displays frame synchronized.

<table>
<thead>
<tr>
<th>System Configuration</th>
<th>Active Stereo Display Modes</th>
<th>Passive Stereo Display Modes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-GPU Mode</td>
<td>The driver does not use the second GPU and automatically switches to single-GPU mode.</td>
<td>The driver does not use the second GPU and automatically switches to single-GPU mode.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>System Configuration</th>
<th>Active Stereo Display Modes</th>
<th>Passive Stereo Display Modes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLI Mode</td>
<td>The driver does not use the second GPU and automatically switches to single-GPU mode.</td>
<td>The driver does not use the second GPU and automatically switches to single-GPU mode.</td>
</tr>
</tbody>
</table>

SLI Mosaic Supported Via NVAPI
Appendix C
Professional 3D Stereo

Supported Stereo Configurations Under Windows Vista/Windows 7

The NVIDIA drivers support both full-screen and windowed stereo under Windows Vista or Windows 7. Table C.2 details which stereo modes are supported under which GPU/display configurations.

Table C.2 Supported Workstation Stereo Configurations under Windows Vista

<table>
<thead>
<tr>
<th>System Configuration</th>
<th>Active Stereo Display Modes</th>
<th>Passive Stereo Display Modes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single GPU - Single display</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Single GPU - Multiple displays</td>
<td>Not supported</td>
<td>Supported (including CloneMode)</td>
</tr>
<tr>
<td>Multi-system - Multiple displays</td>
<td>Not supported</td>
<td>Not supported</td>
</tr>
<tr>
<td>Multi-GPU Mode</td>
<td>Not supported</td>
<td>Supported (including CloneMode)</td>
</tr>
<tr>
<td>SLI mode</td>
<td>Not supported</td>
<td>Not supported</td>
</tr>
</tbody>
</table>
Using Workstation 3D Stereo

Basic 3D Stereo Setup

1 Set up the 3D stereo viewing hardware according to the instructions that came with your hardware.

2 Start the system, then right-click the desktop and click NVIDIA Control Panel to open the panel.

3 From the menu bar, click View then click Advanced.

4 From the Select a Task pane, click Manage 3D Settings, then click the Global Settings tab.

5 Under the Settings: Feature column, click Stereo - Enable, then click the corresponding Setting list arrow and select On.

6 Click Apply.

Typically, the driver detects the type of stereo hardware that is installed and automatically selects the appropriate display mode. If you cannot view 3D stereo with your application after these steps, then manually select the display mode as follows:

1 Re-open the Global Settings tab in the NVIDIA Control Panel Manage 3D Settings page

2 Under the Settings: Feature column, click Stereo - Display mode, then click the corresponding Setting list arrow and select the stereo display mode that is appropriate for your stereo viewing hardware.
   - See Table C.6, “List of Supported Stereo Display Modes” on page 58 for a description of the available modes.
   - If you want to use passive stereo using nView Clone mode, be sure to set up Clone mode using the Set Up Display Configuration page.

3 Click Apply.
### Appendix C

#### Professional 3D Stereo

**Table C.6** List of Supported Stereo Display Modes

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Hardware Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On-board DIN connector</strong></td>
<td>Time sequential, page-flip stereo, with stereo shutter glasses connected directly to a 3-pin DIN VESA connector.</td>
<td></td>
</tr>
<tr>
<td><strong>On-board DIN connector</strong></td>
<td>Time sequential, page-flip stereo, with NVIDIA IR emitter connected to the 3-pin DIN VESA connector via dongle.</td>
<td>NVIDIA GeForce 3D Vision</td>
</tr>
<tr>
<td><strong>Generic active stereo</strong></td>
<td>Any time sequential, page-flip stereo</td>
<td>Displays which accept time-sequential stereo signals</td>
</tr>
<tr>
<td><strong>Generic active stereo</strong></td>
<td>Any time sequential, page-flip stereo using the NVIDIA IR emitter</td>
<td>NVIDIA GeForce 3D Vision</td>
</tr>
<tr>
<td><strong>Shutter Glasses (DDC stereo)</strong></td>
<td>Time sequential, page-flip stereo. Typically implemented using shutter glasses connected to a dongle on the VGA output, but accommodates other hardware that uses page-flipped images. <strong>Not supported on GeForce 8 series and later GPUs (including NVIDIA Quadro FX 4600 and NVIDIA Quadro FX 5600)</strong></td>
<td>IO Display Eyewear, DTI LCD Display, Icuiti LCD Eyewear</td>
</tr>
<tr>
<td><strong>nView Clone Mode</strong></td>
<td>Uses projectors from two displays in <em>nView Clone mode</em>—left image on one display, right image on the other. Passive polarized filters (glasses) isolate the left and right images to the corresponding eyes of the viewer.</td>
<td>Dep3D System</td>
</tr>
<tr>
<td><strong>nView Clone Mode</strong></td>
<td>Clone mode passive to active stereo conversion - the left/right images are displayed through separate monitor outputs and converted to active stereo by the display. <strong>The display feeds the stereo toggle signal into the NVIDIA IR emitter using a 3-pin DIN stereo cable.</strong></td>
<td>projectiondesign F10</td>
</tr>
<tr>
<td><strong>Vertical interlaced stereo monitor</strong></td>
<td>Vertical pixel columns alternate between left and right images. A beam splitter directs the left and right images to the corresponding eyes of the viewer.</td>
<td>SeeReal Technologies</td>
</tr>
<tr>
<td><strong>Color interleaved display</strong></td>
<td>Custom implementation for the Sharp 3D Display, an auto-stereoscopic display that uses a parallax barrier technology to provide 3D stereo on the LCD.</td>
<td>Sharp3D Stereo, Digital Flat Panels</td>
</tr>
</tbody>
</table>
### Table C.6  List of Supported Stereo Display Modes (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Hardware Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal interlaced stereo display</td>
<td>Horizontal scan lines alternate between left and right images. Passive polarized filters (glasses) isolate the left and right images to the corresponding eyes of the viewer.</td>
<td>VReX, Inc.</td>
</tr>
<tr>
<td>3D DLP display</td>
<td>Projector or rear projection TV using Texas Instrument’s Digital Light Processing (DLP) technology. Requires shutter glasses.</td>
<td>Samsung or Mitsubishi DLP HDTV with shutter glasses</td>
</tr>
<tr>
<td>3D DLP display (with NVIDIA IR Emitter)</td>
<td>Projector or rear projection TV using Texas Instrument’s Digital Light Processing (DLP) technology. Requires NVIDIA GeForce 3D Vision IR emitter.</td>
<td>Samsung or Mitsubishi DLP HDTV with NVIDIA GeForce 3D Vision</td>
</tr>
<tr>
<td>3D DLP display INV mode</td>
<td>Use if the “3D DLP display” option results in reversed eyes.</td>
<td>Samsung or Mitsubishi DLP HDTV with shutter glasses</td>
</tr>
<tr>
<td>3D DLP display INV mode (with NVIDIA IR Emitter)</td>
<td>Use if the “3D DLP display (with NVIDIA IR Emitter)” option results in reversed eyes.</td>
<td>Samsung or Mitsubishi DLP HDTV with NVIDIA GeForce 3D Vision</td>
</tr>
</tbody>
</table>
Using Workstation 3D Stereo with Multiple Displays

In a multi-display system, you can move the OpenGL application window to all monitors, although stereo might not be visible on all monitors.

Enabling 3D Stereo with Multiple Displays

To make sure that you successfully enable 3D stereo in a multi-display configuration and avoid losing stereo settings, NVIDIA recommends first enabling stereo in single-display mode and then closing the NVIDIA Control Panel before setting up multi-display modes.

1 Enable 3D stereo
   a Open the NVIDIA Control Panel, then set single-display mode using the Set Up Display Configuration page.
   b Set stereo settings using the Manage 3D Settings page.
   c Close the NVIDIA Control Panel.

2 Enable multiple displays
   Using either the Windows Display Properties page or by re-opening the NVIDIA Control Panel->Set up Display Configuration page, set the desired multi-display mode.

3 Set up other NVIDIA Control Panel->Workstation settings as needed, such as frame locking.

3D Stereo Under nView Modes

Under nView multi-display modes, both displays must be set to the same resolution and refresh rate. If the refresh rates are different, the 3D stereo will be displayed on the display with the highest refresh rate.

3D Stereo Under Dualview Modes

Under Dualview mode, all displays must be set to the same refresh rate for 3D stereo to be displayed on all the Dualview displays. If the refresh rates are different, 3D stereo will be displayed on the display with the highest refresh rate.
This appendix discusses the NVIDIA application configuration engine (ACE) for professional workstation applications. It contains the following sections:

- “Introduction” on page 62
- “Using ACE with Supported Applications” on page 63
- “Using Applications that are not Supported by ACE” on page 65
- “Adding to the List of ACE-detectable Applications” on page 68
- “Frequently Asked Questions” on page 69
Appendix D
NVIDIA Application Configuration Engine

Introduction

Background

Workstation application profiles are a group of software settings used by the NVIDIA graphics driver to provide optimum performance when using a selected application. If there is an available profile for an application, it should be used in order to ensure correct application behavior and optimal performance.

About NVIDIA ACE

With the NVIDIA application configuration engine (ACE), the graphics driver can now detect supported workstation applications and apply the appropriate profile settings automatically—you no longer need to manually select the profile from the NVIDIA Control Panel. If you run more than one application at a time, ACE makes sure that the driver applies the appropriate profile settings to each application.
Using ACE with Supported Applications

When you run an application that is supported by ACE, you do not need to do anything special. The driver will detect the application and apply the appropriate profile settings automatically.

How to Determine ACE Support

To determine whether your application is supported by ACE:

1. Open the NVIDIA Control Panel and make sure that Advanced Settings is selected from the control panel tool bar.

2. From the Select a Task pane, under 3D Settings, click Manage 3D Settings, then click the Program Settings tab. The Select a program to customize list box contains a list of the ACE-detectable applications.

![Manage 3D Settings Page—ACE-detectable applications](image)
Modifying Settings for ACE-detectable Applications

You can modify the settings as follows:

1. Select the application from the *Select a program to customize* box.
   The settings for the application are listed in the *Specify the settings for this program* box.

2. Click the setting you want to change and then select the new setting from the drop-down list.

3. Click **Apply** when you are finished making your changes.
Using Applications that are not Supported by ACE

If your application is not detectable by ACE, then you should configure an application profile and make sure it is set before running the application.

Setting Up an Application Profile Using Global Presets

1. From the Manage 3D Settings page, click the Global Settings tab.

2. Click the Global Presets list arrow.

3. Select one of the global presets:
   - Under Windows Vista
     Select a Base profile or one of the generic 3D App profiles, or create a new profile (see “Adding to the List of ACE-detectable Applications” on page 68).
   - Under Windows XP
Under Windows XP, the driver includes preset profiles for a number of applications that are not ACE-detectable.

Select the application name from the drop-down list.

If your application is not listed, then select Base profile or one of the generic 3D App profiles, or create a new profile (see “Adding to the List of ACE-detectable Applications” on page 68).

4 In the Settings box, you can modify the profile by clicking the setting you want to change and then selecting the new setting from the drop-down list.

5 Click Apply when you are finished making your changes.

If you run a different application that is not ACE-detectable and do not want to use these settings, then repeat these steps for the new application.

Be aware that these settings may affect any ACE profile settings that specify “Use global setting”.

About the Global Presets

Global profiles, or presets, are a set of 3D settings that the driver applies to any workstation application. While a specific profile contains settings that work best with a particular application, the settings are applied to any workstation application you run, as long as there are no ACE-detected program settings to override them.

The following are descriptions of the available global presets:

• Base profile
  This preset lets you configure all the settings, and provides the most flexibility. Other presets allow you to configure only a limited selection of settings.

• 3D App - Default Global Settings
  This preset uses SLI single-GPU rendering mode, and is also useful when you need to use non-SLI configurations.

• 3D App - Game Development
  This preset is useful for game development when using an NVIDIA Quadro card. This eliminates the need for game developers to switch to a GeForce graphics card as the settings cause the Quadro card to run like a GeForce card.

• 3D App - Modeling AFR
  This preset is useful for modeling applications, and uses SLI AFR mode.
• 3D App - Visual Simulation
  This preset is useful for visual simulation applications, and uses SLI SFR mode.

• Application-specific presets (for Windows XP): Table D.7 lists the non ACE-detectable applications for which there are preset global profiles, as of the time this document was created. Consult the actual list in the control panel for the latest list of applications.

Table D.7  Application-specific Global Presets (Not supported by ACE)

<table>
<thead>
<tr>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abaqus CAE / Viewer</td>
</tr>
<tr>
<td>Autodesk AliasSTUDIO</td>
</tr>
<tr>
<td>Autodesk Combustion</td>
</tr>
<tr>
<td>Autodesk Maya</td>
</tr>
<tr>
<td>AVEVA VANTAGE PDMS / Review</td>
</tr>
<tr>
<td>Brainstorm applications</td>
</tr>
<tr>
<td>DENSO NADAMS</td>
</tr>
<tr>
<td>ICEM Surf</td>
</tr>
<tr>
<td>ISD HiCAD</td>
</tr>
<tr>
<td>MAXON CINEMA 4D</td>
</tr>
<tr>
<td>MICROCADAM Helix</td>
</tr>
<tr>
<td>Overwatch Systems RemoteView</td>
</tr>
<tr>
<td>PTC 3DPaint</td>
</tr>
<tr>
<td>PTC Pro/ENGINEER</td>
</tr>
<tr>
<td>RainStorm</td>
</tr>
<tr>
<td>Siemens Medical syngo</td>
</tr>
<tr>
<td>Toyota TOGO</td>
</tr>
</tbody>
</table>
Adding to the List of ACE-detectable Applications

If your application is not listed in any of the profile lists in the Global Settings or Program Settings tab, then you can create a profile for that application as follows:

**Note:** If your application is listed in the Global Settings tab (Windows XP only), then do not create a new profile. Set the global preset for that application instead.

1. From the Manage 3D Settings page, click the **Program Settings** tab.
2. Click **Add**.
3. In the Open dialog box, navigate to the location of your application executable, then click the executable file name and click **Open**.
4. The file name appears in the **Select a program to customize** list box.
5. In the **Specify the settings for this program** box, configure any settings by clicking the setting you want to change and then selecting the new setting from the drop-down list.
6. Click **Apply** when you are finished making your changes.

The new profile will be applied automatically whenever the application is run, just like one of the default ACE profiles.

If your application was running while you created the new profile, you must restart the application in order for the settings to be applied.
Frequently Asked Questions

• What happens when I run more than one ACE-detectable application at the same time?
  The driver detects each application and applies the appropriate profile to each one automatically.

• What happens when I run an ACE-detectable application and a non-ACE-detectable application at the same time?
  The driver applies the global preset to the non-ACE-detected application, and applies the appropriate profile to the ACE-detected application. Note that any settings in the ACE profile that specify “Use global setting” will be controlled by the global preset.

• Can I create my own application profile?
  Only one profile can be created for a specific executable, so if your application is ACE-detectable, do not create another profile for that application.
  If your application is not ACE-detectable, and there is no global preset for it, then you can create a new profile as described in “Adding to the List of ACE-detectable Applications” on page 68.

• Can I create a new global profile for a specific application?
  For applications that are not detected by ACE, you can select an existing global preset and customize it, but you will not be able to save it under a custom name.

• Which global preset should I use?
  Unless you know that a specific global preset is appropriate for your application (see “About the Global Presets” on page 66), it is best to use the Base profile.